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1 About these exercises 

The Getting Started exercises provide an overview of the key tools and features in Ansys Granta 
EduPack, and form a set of tutorials to help you familiarize yourself with the software. You can 
choose whether to work through them in order, or complete only the exercises relevant to you. 

There are also Getting Started video tutorials for Granta EduPack. These can be used independently 
of the exercises, or alongside them, to test and check your knowledge. 

This set of exercises covers the main tools and features available in Granta EduPack 2022 R1 and 
Granta EduPack 2022 R1 Introductory or later. Earlier versions may give different results, or not 
include all features. 

In this document: 

❖ Each step of the exercises is shown on a gold background, like this. 

More detailed instructions appear below the main instruction. 

Text on elements in the software (such as buttons, dialogs and tabs) appears in bold, 
like this. The names of records, datatables, and documents are emphasised like this. 
Words and numbers that you type as you follow the instructions appear in 
monotype, like this. 

More resources to help you get started

For help using the software, or resources for teaching and learning, try: 

 

Granta Edupack Help 

 

Learn Online 

 

FAQs: Ansys Learning Forum 

If you can’t find the answer to your question above, email us at granta-education-team@ansys.com. 

https://www.youtube.com/playlist?list=PLtt6-ZgUFmMK4aApOU0A85CvaJ_udGDCe
http://support.grantadesign.com/resources/grantaedupack/2021R2/help/index.htm?rhcsh=1
http://support.grantadesign.com/resources/grantaedupack/2021R2/learn/index.htm
https://forum.ansys.com/discussion/28641/installation-licensing-of-ansys-granta-edupack-faqs
mailto:granta-education-team@ansys.com
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2 About Granta EduPack 

2.1 Main features and tools 

The main tools in Granta EduPack and Granta EduPack Introductory are: 

 Browse: Explore the database and retrieve records via a hierarchical index or tree. 

 Search: Find information via a full-text search of records. 

 Select: The central hub of Granta EduPack, used to apply the systematic material 
selection methodology. A powerful selection engine that identifies records that meet an 
array of design criteria and enables trade-offs between competing objectives. 

 Chart: Create charts and add formatting and labels to illustrate your point. 

 Eco Audit: Quickly estimate the energy usage and carbon footprint of a product over its 
entire lifecycle, and study What If design scenarios. 

The following tools and features are enabled in all advanced Level 3 databases included in Granta 
EduPack (for example, Level 3 Aerospace and Level 3 Eco Design, but not Level 3):  

 Enhanced Eco Audit: The enhanced version of the tool also accounts for Secondary, 
Joining, and Finishing processes, and includes a cost analysis. 

 Synthesizer: Estimate performance of materials by modelling new hybrid materials, 
battery packs, or the part cost of a design; and compare these results with existing records. 

 Engineering Solver: Quickly calculate the required strength, stiffness or Shape Factor for 
a given design, and include them in a Limit Stage. 

 Find Similar: Select materials based on how similar their properties are to a Reference 
record. 

 Comparison Tables: Compare up to 20 records side-by-side, and highlight the differences 

in their material properties from a Reference record. 

 Selection Reports: Easily record and summarise your complex selection project with an 
automatically generated report. 

The exercises for these advanced features are designed so that Introductory users can simply skip 
them. You will also be prompted to change databases to one that supports the feature.  
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2.2 Chart toolbar guide 

The chart toolbar is displayed between the stage title and chart area on the Chart tab. 

 

 

 

 

 

 

 

*Highlight Reference record  and Highlight synthesized records  are not available in Granta 
EduPack Introductory, and the icon will always be grayed out. 
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3 Browsing and Searching 

 Opening a database 

On starting Granta EduPack, the Databases window will appear, showing all installed databases. The 
following exercises use the MaterialUniverse and ProcessUniverse tables, which are found within all 
Granta material databases. After clicking on a database name in the Databases window to select it, 
the Homepage then opens to show a list of the available tables and a graphic for each subset.  

 

From the homepage you can view more information on the database, select a subset, and access 
online resources for students and educators. 

❖ Select the Level 2 database 

If a feature used in an exercise is not enabled in the Level 2 database, you will asked 
to change to one that does as part of the exercise. Results and images may differ if 
you complete an exercise using a different database. 

❖ Read about the available data and applications 

Click Database information to view a detailed description of the database.  

Click the Back arrow to return to the homepage. 

❖ Select a material subset 

Click one of the subset icons, and notice that the Browse panel appears. 

❖ Change to the ProcessUniverse table 

Click ProcessUniverse and notice that the Browse tree in the left panel updates. 
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❖ Close the Homepage tab 

Click the cross at the top of the Homepage tab. This page can be reopened at any 
time by clicking Home on the main toolbar.  

❖ Change to the MaterialUniverse table 

With the Homepage closed, navigate to different tables using the Table list in the 
Browse panel.  

Table:

Subset:

MaterialUniverse

All materials

Browse Search Select

 

 Browse material records 

❖ Select the MaterialUniverse table and the All Materials subset 

Table:

Subset:

MaterialUniverse

All materials

MaterialUniverse

Ceramics and glasses

Hybrids: composites, foams...

Metals and alloys

Polymers and elastomers

Browse Search Select

 

❖ Find the record for Stainless Steel 

Double-click a folder in the browse tree to view the records and folders below it.  

❖ Open the folder-level record for Polymers 

Folder-level records provide a general overview of a material family, rather than 
containing data on a specific material. They have their own icon: .  
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❖ Open the Polypropylene (PP) record 

Double-click the record name in the tree to view the datasheet. 

Click  to view Science Notes for more information on the property and underlying 
science. 

Right-click the datasheet to see a menu with further actions, for example: Locate in 
Browse tree, Copy or Print the datasheet, and Export the data in a CAD/CAE 
package format. 

❖ Find processes that can shape Polypropylene, by clicking the ProcessUniverse link 
at the bottom of the datasheet. 

 

Part of the Polypropylene Level 2 datasheet 
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 Browse process records 

❖ Browse ProcessUniverse: All Processes 

ProcessUniverse

Table:

Subset:

ProcessUniverse

All processes

Surface treatment

Shaping

Joining

Browse Search Select

 

❖ Find the record for the shaping process Injection molding, thermoplastics 

 

❖ Find the record for the surface treatment process Vapor metallizing (PVD) 

 

❖ Find the record for the joining process Friction welding (metals) 

 

❖ Find materials that can be die cast, using the link to MaterialUniverse at the 
bottom of the datasheet for Gravity die casting 

 Searching 

❖ Find the material Polylactide 

Polylactide

Browse Search Select

 

❖ Find the process Vacuum assisted resin transfer molding (VARTM) 

 

❖ Find materials used for “cutting tools” 

The search matches text on a datasheet. For example, a search for “cutting 
tools” would return all records with the phrase “cutting tools” in the record 
description or supporting information. 
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❖ Find the material Concrete 

The search matches the record's folder name. If the search term appears in a folder 
name, all records under that folder will be returned; for example, a search for 
concrete would return all records in the folder named Cement and concrete e.g. 
Plaster of Paris. 

❖ Enter the search term alum* 

Records containing the terms Alumina, Aluminum or Alumino are returned.  

Advanced searches 

The following search operators are available: 

Operator Description 

AND Finds records containing both the search terms, so steel AND alloy 
returns only records containing both the words steel and alloy 

OR Finds records containing either search term, so steel OR alloy returns 
all records that contain steel, alloy, or both 

NOT Finds records containing the first search term, but not the second, so 
steel NOT alloy returns only records with the word steel but without 
the word alloy 

Phrase Search Finds the exact search term, so “steel alloy” will return only records 
containing the exact phrase steel alloy 

Parentheses  Used to group search terms, so iron AND (ore OR cast) will return the 
records containing iron and containing either ore, cast, or both 

Wildcards  Use ? as a wildcard single character, or * as a wildcard representing any 
number of characters (these cannot be used as the first character in a 
search string) 

Note:  AND operators are automatically added when a search has two or more terms 
and no other operators have been entered.  
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4 Creating property charts 

Bar charts and bubble charts are a great way to visualize and communicate material properties, as 
well as being a key tool to support systematic materials selection. 

 Create a bar chart 

❖ Select MaterialUniverse: All materials 

Click Chart/Select, and then select MaterialUniverse: All materials. 

❖ Create a bar chart of Young’s modulus (E) 

Under Selection Stages, click Chart/Index. 

Set the Y-axis attribute to Young's modulus, and click OK. 

For a bar chart, you do not set an X-axis: leave its attribute set to <None>. 

2. Selection Stages

Chart TreeLimit

1. Selection Data

Select from: MaterialUniverse: All materials

Young s modulusAttribute:

Y-axis

Chart Stage

SearchBrowse Select

 

❖ Explore the chart 

Click Zoom in  and then drag to zoom in on an area of the chart. 

Click Zoom out  to zoom out. 

Click Autoscale  to zoom back to view the whole chart again. 

❖ Label records on the chart 

Click a record on the chart and then drag to add and position a new data label.  

To delete a data label, select it and press DELETE. To delete all labels in the chart, 
press CTRL+A and then press DELETE. 
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 Create a bubble chart 

❖ Make a bubble chart plotting Young’s modulus (E) against Density (ρ) 

Under Selection Stages, click Chart/Index. 

Set the Y-axis to Young’s modulus and set the X-axis to Density.  

Leave the Axis Settings as default values to create a log-log plot.  

2. Selection Stages

Chart TreeLimit

1. Selection Data

Select from: MaterialUniverse: All materials

Chart Stage

Young s modulusAttribute:

Y-axis

DensityAttribute:

X-axis

SearchBrowse Select
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❖ Display family envelopes 

Click Show Family Envelopes  to look at how data for a given family of materials 
cluster together. 

❖ Label records on the chart 

Hover the cursor over the record bubble to see the record name, and then label 
some records (click over a record and drag). 

Try adding labels from the Results list: right-click a record in the list, and select Label 
on the shortcut menu, then drag the label where you want it on the chart. 

If the new label isn’t visible at the current zoom, click Autoscale  to display the 
whole chart again. 

 

❖ Delete this stage 

Select the stage in the Selection Stages list and press DELETE. 
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5 Filtering and screening 

 Selection using a Chart Stage 

When plotted on a Chart, records can also be filtered using the Index line and Box selection tools.  

2. Selection Stages

Chart TreeLimit

Density

Yi
el

d
 s

tr
en

gt
h Index line

Yi
el

d
 s

tr
en

gt
h

Box 
selection

Bar chart1

Bubble chart2

3. Results X out of Y pass

Material 1

Material 2

Material 3

Material 4

etc.

1. Selection Data

Select from: MaterialUniverse: All materials

SearchBrowse Select

 

❖ Create a bar chart of Yield strength (σy) 

Set the Y-axis to Yield strength (elastic limit). 

❖ Use a Box selection to identify materials with high values of Yield strength 

Click Box selection , then drag to define the selection box. 
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❖ Add Density (ρ) to the X-axis 

Click Chart Settings , then go to the X-Axis tab and select Density as the X-axis 
attribute. You can also double-click the chart axis to open the dialog. 

❖ Use an Index line to identify materials with high values of specific strength, σy / ρ 

Click Index and display lines . 

Use the default Slope value of 1. 

The objective of the line is set to Maximize the index by default, which will result in 
selection of materials above the line, for high values of σy / ρ.  

Click OK, then click the chart to position the line through a particular point.  

Drag the line upwards to refine the selection to fewer materials. 

❖ Add a Box selection to the chart to identify materials with low Density that 
maximize the index. 

 

❖ Rank the Results list by specific strength (Yield strength / Density) 

Show: Stage 1: Yield strength v. Density 
Rank by: Stage 1: Index value. 
Example results: Bamboo, Cork, Rigid Polymer Foam (MD). 

❖ Delete this stage 

Select the stage in the Selection Stages list and press DELETE. 
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  Selection using a Limit Stage 

❖ Select materials with specific thermal and electrical properties. 

Create a new Limit Stage with the following criteria: 

Maximum service temperature > 200 °C 

Thermal conductivity  > 25 W/m.°C 

Electrical resistivity  > 1e15 μohm.cm 

Use the limit bars  for guidance on suitable values. Enter the limits – minimum or 
maximum as appropriate – and click Apply.  

You can change the units on the datasheet by going to the Units tab under Settings. 

Example results: Aluminum nitride, Alumina, Silicon nitride. 

1. Selection Data

Select from: MaterialUniverse: All materials

3. Results X out of Y pass

Material 1

Material 2

Material 3

Material 4

etc.

Max. service temp.

Thermal conductivity

°C200

25 W/m.°C

Min Max

Limit Stage

Mechanical properties

Thermal properties

Electrical  properties

Electr ical resistivity μohm.cm1e15

Min Max

Limit 

Guidance

2. Selection Stages

Chart TreeLimit

SearchBrowse Select

 

❖ Filter the results further to select only materials which are resistant to 
Hydrofluoric Acid (40%). 

Under Durability: Acids, select Acceptable and Excellent for Hydrofluoric Acid (40%).  

Click Apply. Silicon nitride should be the only passing record. 
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 Selection using a Tree Stage 

Using a Tree Stage, you can filter records by category based on their links to records in other data 
tables, or based on the database hierarchy (tree). For example, you can filter records that are linked 
to specific process record. 

❖ Find materials that can be molded 

Under Selection Stage, click Tree. In the Tree Stage dialog, select 
ProcessUniverse and navigate to Molding.  

Select the folder, click Insert, then click OK. 

❖ Click Show to view a list of MaterialUniverse records to which this process folder 
is linked. 

Double-click a record name to view its datasheet. 

 

1. Selection Data

Select from: MaterialUniverse: All materials

3. Results X out of Y pass

Material 1

Material 2

Material 3

Material 4

etc.

2. Selection Stages

Chart TreeLimit

Tree stage for processes

Joining

Shaping

Surface 
treatment

Casting

Deformation

Machining

Molding

Process

SearchBrowse Select

 

❖ Delete this stage. 

 

❖ Find processes which can join Ferrous Metals and alloys 

In the Selection Project panel, under Selection Data, select ProcessUniverse: Joining.  

In the Tree Stage dialog, select MaterialUniverse, expand Metals and alloys, select 
Ferrous, and then click Insert followed by OK. 

Click Show to view the linked records. 

❖ Delete this stage. 
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6 Putting it all together 

 Combining filtering and charting tools 

1. Selection Data

Select from: MaterialUniverse: All materials
Limit stage

Density

Yield strength

T-conductivity

2000

60

10

Min Max

1

P
ri

ce

Chart stage3

Casting

Forming

Deformat ion

Machining

Molding

Powder

Surface

Process

Join

Shape

Tree stage2

3. Results X out of Y pass; ranked by PRICE

Material 1

Material 2

Material 3

Material 4

etc.

2. Selection Stages

Chart TreeLimit

SearchBrowse Select

 

❖ Choose the data table 

Select from: MaterialUniverse: All materials. 

❖ Select materials with specific physical, mechanical, and thermal properties. 

Create a Limit Stage with the following criteria: 

Density    < 2000 kg/m^3 

Yield strength (elastic limit) > 60 MPa 

Thermal conductivity  < 10 W/m.°C 

❖ Filter the results to find those that can be Thermoformed 

Create a Tree Stage and Insert ProcessUniverse > Shaping > Molding > Thermoplastic 
molding > Thermoforming. 
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❖ Rank the results by Price and find the three cheapest materials 

Create a Chart Stage with a bar chart of Price on the Y-Axis. On the chart, all 
materials that fail one or more stages are grayed out. The Results panel lists the 
materials that pass all stages by default. 

In the Rank by menu, select Stage 3: Price. 

 Process selection 

The Chart, Limit, and Tree selection stages can be used to filter ProcessUniverse records in the same 
way as for MaterialUniverse. 

❖ Select the data table  

Select from: ProcessUniverse: Shaping. 

❖ Find Primary shaping processes to make a component with specific shape, 
physical, and economic properties. 

Add a Limit Stage with five criteria: 

Shape    Dished sheet 

Mass range   10 - 12 kg 

Range of section thickness 4 mm 

Process characteristics  Primary shaping process 

Economic batch size  > 1000 

❖ Filter the results to only include Thermoplastic materials 

Add a Tree Stage and Insert MaterialUniverse > Polymers and Elastomers > Polymers 
> Thermoplastics. 

Example results: Rotational molding, Compression molding, Thermoforming. 
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2. Selection Stages

Chart TreeLimit

Ceramics

Hybrids

Metals

Polymers
Polymers

Material
Thermoplastics

1. Selection Data

Select from: ProcessUniverse: Shaping
Limit stage1

Mass range

Range of section thickness

kg10 12

4 4 mm

1000Economic batch s ize (units)

Primary shaping processes ✓

Shape

Dished sheet ✓

Physical and quality attributes

Process characteristics

Economic compatibility

Tree stage2

Elastomers

Thermosets

SearchBrowse Select

 

 Advanced selection using the Performance Index Finder 

Note:  The Performance Index Finder is only enabled in Level 3 databases. 

The Performance Index Finder is a tool which lets you plot performance indices on a chart for a given 
design situation, without having to derive an index from first principles. 

In this exercise, you will use the Performance Index Finder to find the materials best suited for a 
beam, loaded in bending, that is part of a low-cost, low-weight, strength-limited design. 

❖ Select a Level 3 database and data table 

Click Change… under Selection Data to change the database to Level 3. 

Select from: MaterialUniverse: All bulk materials. 

❖ Create a chart using the Performance Index Finder 

Click Chart/Index, then select the Performance Index Finder radio button. 
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❖ Enter the Component Definition for the Y-Axis 

Function and Loading:  Beam in bending 

Limiting Constraint:  Strength 

Optimize:   Mass 

Keep the default values for Free and Fixed Variables, and Axis Settings. 

❖ Enter the Component Definition for the X-Axis 

Go to the X-Axis tab and select Performance Index Finder. Set the following values: 

Function and Loading:  Beam in bending 

Limiting Constraint:  Strength 

Optimize:   Cost 

Keep the default values for Free and Fixed Variables, and Axis Settings. 

❖ View the chart 

Click OK to view the chart. 

Materials in the bottom-left corner are best suited for a low-weight, low-cost, 
strength-limited design.  
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 Advanced selection with Comparison Tables 

Note:  Comparison Tables are only enabled in the advanced Level 3 databases; the 
option will be grayed out or not appear at all if you have opened any of the databases 
available in Granta EduPack Introductory, including Level 3. 

In industry, materials selection projects are often required to find a replacement for an existing 
material, due to changes in the design or manufacture of the component, or because of supply chain 
issues. Comparison Tables allow you to compare several different records at once, and highlight 
differences between them. 

❖ Change the database to one where Comparison Tables are enabled 

Change the database and table to Level 3 Polymer, MaterialUniverse: All materials. 

❖ Add an unfilled PP (Polypropylene) and an unfilled high-density PE (Polyethylene) 
record to a Comparison Table. 

Find an example of each in the Browse tree, then right-click and select Add to 
Comparison Table. 

Search SelectBrowse

Table:

Subset:

MaterialUniverse

All materials

MaterialUniverse

...

Polymers: plastics, elastomers

Plastics

Thermoplastics

PP (Polypropylene)

Unfilled

Random copolymer, high flow

 
Set as Reference
Add to Comparison Table
...

 

❖ Set the high-density PE as the Reference record 

Hover over the record name in the comparison table header and click 

Set as Reference . 

Note:  Reference record is another feature enabled in the advanced Level 3 databases. 

Setting a Reference record allows you to easily identify it in the browse tree and on 
charts, and compare other records to it using Comparison Tables and Find Similar (see 

the next exercise and the software Help for more information). 



Getting Started with Granta EduPack 

© 2022 ANSYS, Inc. or its affiliated companies. All rights reserved.  / 24 

 

❖ Show the differences relative to the Reference record as percentages 

Click Change in the Comparison Table toolbar. 

Note that these are differences in the range values, not the averages. 

❖ Clear the Comparison Table and Reference record 

Click Tools on the main toolbar, then select Comparison Table > Clear > 
MaterialUniverse. Repeat for the Reference record. 

 
Reference Record
Comparison Table
...

Clear
View

All Tables
MaterialUniverse

Tools

 

 Advanced selection with Find Similar and Limit Stage 

Note:  Find Similar is only enabled in the advanced Level 3 databases. This exercise 
assumes you are using the Level 3 Polymer database from the last exercise. 

❖ Open the record for Polypropylene (Copolymer, Conductive, 5% Carbon powder) 

 

❖ Find records similar to it 

Click Find Similar at the top of the datasheet tab. Polypropylene (Copolymer, 
Conductive, 5% Carbon powder) will become the Reference record. 

Use the default weightings to calculate nearness; do not open the Nearness Settings 
dialog. 



Getting Started with Granta EduPack 

© 2022 ANSYS, Inc. or its affiliated companies. All rights reserved.  / 25 

❖ Compare the current material with the nearest alternative 

Select one of the closest records from the list of results, PP (copolymer, 10% talc), 
and open a comparison table by clicking Comparison…. 

PP (copolymer, conducti...

PP (copolymer, conductive, 5% carbon powder)

Find SimilarLayout: All attributes

Records similar to: PP (copolymer, conductive, 5% carbon powder)

Name Nearness (%)

PP (copolymer, conductive, 5% carbon powder)

PP (copolymer, 10% talc)

PP (copolymer, 20% calcium carbonate)

PP (impact copolymer, high flow)

etc.

100

94

94

94

✓

✓

Comparison...

Comparison

Comparison - MaterialUniverse

Density (kg/m^3)

    PP (carbon) PP (talc)

961 966

Electrical resistivity (μohm.cm) 3.16e11 7.14e23

29.1Compressive strength (MPa) 23.4

 

The Comparison Table is highlighted where there is a difference between the original (reference) 
and alternative materials. The nearest materials in the results have similar physical properties to the 
reference material (density, yield strength, Young’s modulus). However, the original material may 
have been chosen for its other characteristics. In this case, the polymer is conductive (has a low 
electrical resistivity). 

To find materials which have all the properties we need, we can proceed in one of two ways: 

• Adjust the Nearness Settings to prioritise the material properties most important to our 
application (see Exercise 16). 

• Use the results from Find Similar as the basis of a Selection Project. In this case, you can use 
a Limit Stage to filter on the additional requirement for conductivity. 
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❖ Create a Selection Project using the results 

In the Records similar to dialog, click Selection Project. The results are loaded into a 
new project, ranked by nearness. 

❖ Filter the results for an Electrical resistivity that is equal to or lower than that of 
the reference material 

Create a Limit Stage, and set the maximum value for electrical resistivity to 3.16e12, 
which is the maximum value for the reference record. Apply the stage. 

Records similar to: PP (copolymer, conductive, 5% carbon powder)

Name Nearness (%)

PP (copolymer, conductive, 5% carbon powder)

PP (copolymer, 10% talc)

PP (copolymer, 20% calcium carbonate)

PP (impact copolymer, high flow)

etc.

100

94

94

94

✓

✓

Selection Project...

Chart/Index Limit Tree

2. Selection Stages

Limit Stage

Electrical properties

Electr ical resistivity μohm.cm3.16e12

Min Max Reference

3.16e10 – 3.16e12

 

Example results, with Nearness (%):  

• PP (10-12%, stainless steel fiber) - 86%  

• PP (10% carbon fiber) - 82% 

• ABS (40% aluminum flake) - 79% 

❖ Delete this stage. 
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 Advanced selection with Find Similar and Nearness Settings 

Instead of filtering on additional attributes, you can change the criteria used for calculating nearness 
to take account of different requirements. 

Note:  Find Similar is only enabled in the advanced Level 3 databases. This exercise 
assumes you are using the Level 3 Polymer database from the last exercise. 

❖ Find records similar to Polypropylene (Copolymer, Conductive, 5% 
Carbon powder) 

Open the datasheet and click Find Similar.  

❖ Re-calculate the list of alternative materials, taking Electrical resistivity into 
account and prioritizing results with a resistivity that is the same or lower than 
the reference material 

Click the Nearness settings link on the Records Similar to dialog.  

Under Electrical Properties, select Electrical resistivity. Set it to 100% when Same or 
lower, and increase the Weighting factor to 2.  

Click OK to generate the new results.  

Note:  These results are conceptually different to those from the previous exercise. We 
have ranked similar materials, taking into account the resistivity, but there is not a fixed 
upper limit as there was when filtering using the Limit Stage. Materials with a higher 
resistivity than the reference will still be included in these results.  
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 Calculate values for a Limit Stage using Engineering Solver 

Design requirements are often specified in terms of geometry, loading, and maximum deflections. 
The Engineering Solver tool converts these engineering requirements into material properties, which 
can then be applied in a Limit Stage to screen for suitable materials. 

Note:  Engineering Solver is only enabled in the advanced Level 3 databases. This 
exercise assumes you are using the Level 3 Polymer database from the last exercise. 

❖ Open the Engineering Solver. 

Click Solver  on the main toolbar. 

❖ Select the loading geometry Beam in Bending 

This model estimates the minimum strength, stiffness and Shape Factor values 
required for a beam with the specified geometry and load conditions. 

❖ Enter the geometry for an I-beam with the following dimensions: 

 
Use the Cross-section list to select I-section. Enter the following 
dimensions and use the drop-down lists at the end of each line to select 
the correct units:  
Breadth, b = 100 mm; Depth, d = 250 mm; Thickness, t = 10 mm; 
Web thickness, tw = 10 mm; Length, l = 5 m. 

❖ Enter the design parameters for a cantilever with an end load of 5 kN 

Load condition = Cantilever End load; Load = 5 kN; Safety factor = 1.5; Maximum 
deflection = 50 mm. 

The results are populated automatically. You should see that the minimum required 
Young’s Modulus is 133 GPa and the minimum Yield Strength is 108 MPa. 

Keep the Engineering Solver dialog open. 

❖ Select materials based on the results from Engineering Solver  

Create a new Limit stage using MaterialUniverse: All bulk materials, and enter the 
minimum Young’s modulus and Yield strength (elastic limit) estimated by the Solver. 
You can copy and paste from the dialog using CTRL+C and CTRL+V. 

Make sure the units in the Engineering Solver and Limit Stage match; change the 
results units in the Engineering Solver dialog if they do not. 

Over a third of the materials in the database meet the requirements. Typically, you 
would apply more constraints and selection stages to narrow the list further. 

❖ Delete this stage, and Change database back to Level 2 
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7 Saving, copying, and report writing 

 Adding comments and saving a project 

You can add comments (Notes) to a selection project as a reminder of why you have applied certain 
constraints and objectives. Comments are displayed on mouse-over in the stage tab, and are saved in 
the project file. 

Notes can be added to each selection stage as below, or to the overall project (in Project Settings).  

2. Selection Stages

Chart TreeLimit

Stage

Limit

Stage Settings

Title

Notes

Limit

Stage

 

❖ Click Notes in the stage window heading to open the Stage Settings dialog, 
then enter some comments in the Notes box. 

 

❖ Save your project 

On the File menu, click Save Project. Give the project a filename and folder location; 
the project will be saved with the file extension .ces.  

 Copying charts, data and results lists 

Charts, records, and results lists can be copied and pasted into a document in another application 
such as Microsoft® Word, Microsoft Excel, Microsoft Powerpoint, or Notepad.  

❖ Copy a chart into a document 

To copy a chart to the clipboard: in the chart window, right-click the chart and select 
Copy on the shortcut menu, or press CTRL+C.  

You can then paste the chart image from your clipboard into the document as a 
device-independent bitmap.  
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❖ Copy a datasheet into a document 

To copy a datasheet to the clipboard: display the datasheet, then right-click the 
datasheet and select Copy on the shortcut menu, or press CTRL+C. 

You can then paste the data from your clipboard into the document.  

❖ Copy results into a document 

To copy results to the clipboard, use SHIFT+click or CTRL+click to highlight the 
records you want, then right-click and select Copy on the shortcut menu, or press 
CTRL+C. 

To select all results in the list, right-click and select Select All on the shortcut menu, 
or press CTRL+A. 

You can then paste the results from your clipboard into the document.  

❖ Edit the document you have created 

 Exporting Selection Reports 

Note:  Selection Reports are only enabled in the advanced Level 3 databases (e.g Level 3 
Eco Design); the option will not appear if you have opened any of the databases 
available in Granta EduPack Introductory, including Level 3. 

❖ Generate a Selection Report 

Click Selection… at the bottom of the Chart/Select pane. 

❖ Export the report as a PDF 

Click Export   and select PDF. Selection Reports can be exported as a PDF, a 
Microsoft® Word document, or a Microsoft Excel spreadsheet. 

4. Reports

Comparison Selection

Report

Project Summary

Excel

PDF

Word
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8 Eco Audit tool 

The Eco Audit tool estimates the energy used and CO2 produced during the four key life phases 
of a product (material, manufacture, use, and end of life) and transport, and identifies which phase 
has the dominant contribution. This is the starting point for eco-aware product design, as it identifies 
which parameters need to be targeted to reduce the eco-footprint of the product. 

The next few exercises will take you through a case study for a brand of bottled mineral water. It is 
sold in 1 liter PET bottles with polypropylene caps. A bottle weighs 40 grams; the cap 1 gram. Bottles 
and caps are molded, filled, and transported 550 km from the French Alps to England by 14 tonne 
truck, refrigerated for 2 days and then sold. The overall life of the bottle is one year. 

An example product file for this case study is installed with Granta EduPack in the Samples folder, 
with the filename Level 2 - Bottle PET.prd. Eco Audit .prd files can only be opened and saved from the 
Eco Audit tab, and are saved separately from selection project files (.ces). 

Note:  The Enhanced Eco Audit tool contains warnings about restricted substances, 
and options to include a cost analysis or a secondary process in the audit. For more 

information on these advanced features, see the Help or the teaching resources on 
Granta’s Education Hub. 

 Define and audit a product 

To view an explanation of the calculations used at each stage, click the Help icon  in the header.  

❖ Enter material, manufacture, and end of life details 

Bill of materials (BoM) and primary processing method. 

Qty

Component 

name Material

Recycled 

content

Primary 

process

Mass 

(kg) End of life

Virgin (0%)
Polymer extrusion

Recycle

Landfill

Combust

Downcycle

Re-manufacture

Reuse

Polymer moldiVirgin (0%) 0.04PET .. .Bottle100

None

Polymer molding

MaterialUniverse

PET

Polymer moldiVirgin (0%) 0.001PPCap100

1Dead weight100

Recycle

Landfill

None

Thermoplastics

Ceramics and glasses

Electr ical components

Hybrids: composites, . ..

Metals and alloys

Polymers: plastics, elas
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❖ Enter transport details 

Transportation from site of manufacture to point of sale. 

Ocean freight

Rail freight

14 tonne truck

...

Air freight – long haul

Name Transport type Distance (km)

Fil ling plant to retailer 14 tonne (2 axle) truck 550

14 tonne (2 axle) truck

 

❖ Enter Product life and Country of use 

Expected product lifetime and geographic region where it will be used. 

France

Germany

United Kingdom

.. .

Product life: years

Country of use:

1

United Kingdom

United K ingdom

 

❖ Enter details of energy consumption during product use 

Energy is used to refrigerate the product at point of sale (average energy required to 
refrigerate 100 bottles at 4°C = 0.12kW). Enter this under Static Mode. 

(This product is not part of a vehicle, so there is no Mobile Mode entry.) 

Product uses the following energy:

Energy input and output:

Power rating:

Usage:

Usage:

days per year

hours per day

Electric to mechanical (electric motors)

0.12

2

24

kW
Electr ic to thermal

Electric to mechanical (electric motors)

Electr ic to chemical (lead acid battery)

...

 

❖ View the Summary Chart and Eco Audit Report 

Click Summary chart. The chart enables rapid identification of the dominant life 
phase. Toggle between plots of energy usage or CO2 footprint.  

For this product, Material is the dominant life phase. Each life phase can be clicked 
to show guidance on strategies to reduce its impact. 
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Click Detailed report to view a component-by-component breakdown of each life 
phase. The Report can be saved as a PDF or Word document. 

 Compare products with Eco Audit 

This exercise assumes you have completed Exercise 20: Define and audit a product. 

❖ Create a copy of your product for comparison 

Click Compare with on the Product Definition tab and select Copy of current 
product. 

Eco Audit Project

New Open Save Compare with      

Product definition

Copy of current  product

New product

Saved product ...

Compare with      

 

❖ Change the Product name to PET Bottle (Recycled) 

 

❖ Change the Recycled content value for PET to 35% 

Click in the box to manually type in a value. 
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❖ Generate the Summary chart 

 

The first life energy (not including EoL potential) is reduced by 12%.  

Note:  The Summary chart can be copied into a document or printed using Copy and 
Print at the top of the chart window.  
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 Saving and exporting 

Eco Audit product definitions and reports do not form part of a selection project, and need to be 
saved separately. 

❖ Save your product definition 

Eco Audit Project

New Open Save Compare with      

Product definition Report

 

❖ Generate an Eco Audit Report 

Click the Report tab (or click Detailed Report on the Product definition tab). 

❖ Export the report as a PDF 

Click on the disk icon at the top of the Report tab, and select PDF. 

You will require a PDF reader such as Adobe Reader to view the exported report. 

Product definition

Excel

PDF

Word

Eco Audit Project

New Open Save Compare with      

Report
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9 Synthesizer tool 

Note:  The Synthesizer tool is only enabled in the advanced Level 3 databases (e.g Level 
3 Eco Design); the toolbar icon will be grayed out if you have opened any of the 
databases available in Granta EduPack Introductory, including Level 3. 

The Synthesizer tool is designed for use in the early stage of product development. It consists of 
three types of model: hybrid models, for estimating the performance of novel materials and 
structures; Part Cost Estimator, for calculating the cost of a component based on the materials and 
processes used; and Battery Designer, for comparing early-stage battery module and pack designs. 

Synthesized records produced using the Synthesizer tool can then be compared with existing records 
in the MaterialUniverse database using selection stages. 

 Model hybrid materials with the Sandwich Panels model 

Hybrid materials and structures combine the benefits of two or more materials to produce new 
materials that exhibit unique combinations of properties. For example, both composite materials and 
sandwich panels are commonly used to create strong, lightweight structures.  

❖ You will need to use an advanced Level 3 database for this exercise. 

Change the database to Level 3 Polymer. 

❖ Plot Young’s modulus (E) against Density (ρ) using the MaterialUniverse: All bulk 
materials subset 

As in Exercise 6. 

❖ Use the Sandwich Panels model to create synthesized records for a family of 
hybrid materials 

Click Synthesizer on the toolbar (or click Tools > Synthesizer on the menu bar).  

Select the Sandwich Panels – Balanced model.  

Synthesizer

 

❖ Set the Source Record values 

Face-sheet: Aluminum, 6061, T6 (wrought) 

Core:  Polymethacrylimide foam (rigid, 0.200) 

Click Browse (…) and locate the records in the browse tree. 
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❖ Keep the default values for Model Variables and Model Parameters, and set the 
following Record Naming values: 

Face-sheet: Al 

Core:  Rohacell 

❖ Create the synthesized records 

Click Create and then Finish. The new synthesized records are shown in the Results 
list and on the Chart Stage. 

Note:  Click the blue Help icon or press F1 in the Synthesizer tool dialog to view further 
information about the current model type, including details of the calculations used. 

❖ Plot an Index line corresponding to a lightweight, stiff panel in bending: E1/3/ρ 

Click Index and display lines , enter a slope value of 3, and select maximize the 
index. Click on the plot area to place the index line, then click and drag to change its 
position. 

❖ Add labels to the source records and some of the synthesized records  

You can click individual records on the chart and drag to place a label. 

You can also add labels from the Results list: select one or more records in the list, 
right-click and select Label on the shortcut menu, then drag the labels where you 
want them on the chart. 

Click the Highlight synthesized records button to help you identify the 
synthesized records on the chart.  

Use the Zoom controls  and  to zoom in to the area of interest on the chart. 
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❖ Navigate to your synthesized records in the Browse panel 

Synthesized records appear on the browse tree under My Records and may be 
edited or deleted in a similar way to User Defined records.  

MaterialUniverse

...

My records

Synthesized

...

20mm core

Add Record

Edit Record

Delete Record

0.05mm Al face-sheet

0.0834mm Al face-sheet

 

❖ Delete the Chart Stage 

 Part Cost Estimator 

The Part Cost Estimator is a Synthesizer model that calculates the total cost of a component based 
on the material and processing costs. 

❖ You will need to use an advanced Level 3 database for this exercise 

 

❖ Use the Part Cost Estimator to compare the cost of a component when 
manufactured as an injection-molded polymer, or a rolled and pressed metal 

Click Synthesizer on the toolbar. In the dialog, select Cost – Part cost estimator. 

❖ Enter the Component Details for the first component 

Material:   PP (copolymer, 20% talc) 

Value of scrap material: 10% 

Part mass:   6.4 

Part length:   10 

Batch size:   1000 - 1E6 

Number of values:  10 

For this exercise, the units of part mass and part length do not matter. 

❖ Enter the Primary Shaping Process values 

Primary process: Injection molding (thermoplastics) 

Availability:  Custom form 

Part complexity: Standard 

Use the default values for Load factor, Overhead rate, and Capital write-off time. 
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❖ Set the Record Naming values 

Material:  PP 

Primary process: molded 

❖ Create the new records 

Click Create. Keep the Part Cost Estimator dialog open. 

❖ Enter Component Details for the second component 

In the Part Cost Estimator dialog, click Previous and change the Component Details: 

Material: YS170 hot rolled (a high strength, drawing quality steel) 

Part mass: 10 

Use the existing values for scrap material value, part length, batch size, and number 
of values (these are retained from the first material processing chain input). 

❖ Enter Primary Shaping Process values 

Primary process: Hot shape rolling 

Use the existing values for the remaining properties. 

❖ Enter details for the Secondary Shaping Process 

Select Include secondary process, and enter the following value: 

Secondary process: Press forming 

Use the default values for Part complexity, Amount of scrap, and Scrap recycled. 

❖ Enter the Record Naming values 

Material:  Steel 

Primary process: rolled 

Secondary process: pressed 

❖ Click Create and then Finish to create the records and close the Part Cost 
Estimator 

Synthesized records created using Part Cost Estimator are appended to the 
MaterialUniverse browse tree under My records > Synthesized > Part cost estimator.
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❖ Create a bubble chart to compare the two material processing chains 

Select MaterialUniverse: All bulk materials, click Chart, and set the following x- and 
y-axis values: 

Category:  Part cost estimator 

X-Axis Attribute: Batch size 

Y-Axis Attribute: Part cost 

❖ Change the Record color for easy comparison of the two processing chains 

Navigate to My records > Synthesized > Part cost estimator. Right-click the PP, 
molded subfolder, click Record color, and click a color to change the record color for 
all records in that folder.  

 

❖ Delete the Chart Stage 
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 Battery Designer 

Battery Designer is a Synthesizer model that estimates the performance of battery module and pack 
designs based on the materials, battery cell type, and thermal management system used. 

❖ You will need to use an advanced Level 3 database for this exercise 

 

❖ Create a bubble chart to compare individual battery cells. 

On the Chart/Select panel, Select from: Battery Cells: All Cells. 

Click Chart/Index and set the following x- and y-axis values: 

Category:  General 

X-Axis Attribute: Specific power 

Y-Axis Attribute: Specific energy 

 

Charts of Specific energy against Specific power are also known as Ragone plots. 

By default, this will display all cells in the Battery Cells table, as well as any 
synthesized Module and Pack records in the Selection Project. 

❖ Use the Battery Designer to estimate the performance of an example multi-cell 
module configuration 

Click Synthesizer on the toolbar. In the dialog, select Battery Designer - Cell to 
Module (by number of cells). 
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❖ Under Module, enter the name and battery cell type 

Name:  Test Module 1 
Battery Cell:   Lithium-ion (NCA) Cylindrical 3500 mAh 

❖ Set the Number of cells and target Discharge Current 

Number of cells in series: 10 

Number of cells in parallel: 2 

Discharge current:  7A 

❖ Select a custom Configuration 

Check the Or custom configuration checkbox.  

Make sure the Pre-defined module checkbox is not selected. 

❖ Set Packaging materials and dimensions: 

Casing material:  PC (high viscosity, molding and extrusion) 

Wall thickness:   3 mm 

Insulation material:  PC foam (rigid, closed cell, 0.65) 

Insulation thickness:  3 mm 

Cell spacing:   1 mm 

❖ Select a Thermal management system (TMS) 

Cooling system type:  Passive air cooling 

❖ Click Create and then Finish to create the synthesized record and close the 
Battery Designer 

Synthesized records created using Battery Designer are appended to the Battery 
Cells table under My records > Synthesized > Modules. 

❖ Go back to the bubble chart 

The new Module record is now displayed on the Ragone plot. 
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❖ Now create some Module records based on desired performance, and compare 
them to the existing Module 

Click Synthesizer and in the dialog, select Battery Designer - Cell to Module (by 
performance). 

❖ Enter the Module details: 

Name:  Test Module 2 
Battery Cell:  Lithium-ion (NCA) Cylindrical 3500 mAh 

❖ Set the target Performance: 

Should last for at least 60-240 min 
Number of values: 10 

with Current   7 A 

and Voltage   36 V 

❖ Select custom Configuration 

 

❖ Set the Packaging materials and dimensions: 

Casing material:  PC (high viscosity, molding and extrusion) 

Wall thickness:   3 mm 

Insulation material:  PC foam (rigid, closed cell, 0.65) 

Insulation thickness:  3 mm 

Cell spacing:   1 mm 

❖ Set the Thermal management system (TMS) 

Cooling system type:  Passive air cooling 

❖ Create Module records 

Click Create and then Finish. 

❖ Compare Module records using the bubble chart 

All the synthesized Modules can now be compared with each other and with 
individual cells.  

You can also open Module datasheets to view other calculated properties associated 
with that module, for example predicted operating temperature and discharge time.
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To reproduce this chart: 

• Set Lithium-ion (NCA) Cylindrical 3500 mAh as the Reference record. 

• Select Highlight Synthesized Records and Highlight Reference Record 
on the Chart toolbar. 
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